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About this document

Please note: This document is a guide for using the Ul Thesis Template with Word 2008 — please check for updated versions

of this document on our website (http://cs.its.uiowa.edu/sda/index-thesis.shtml) which will contain additional information,
directions and screen shots not yet included in this document. We welcome any feedback and/or suggestions pertaining to this
document (e.g., What is helpful/not helpful? Are there any steps which are not clear? Is there any additional information or
directions you would like to see included in this document?). Please direct feedback and/or suggestions pertaining to this document
to

its-helpdesk@uiowa.edu, and include “Ul Thesis Template for Word 2008 Feedback” in the Subject line of your message.

What is included in this document?
e  Step-by-step instructions for attaching the Ul Thesis Template to your thesis documents

e Information pertaining to macros (which will allow you to automatically create your Preliminary Pages and Doctoral
Abstract within minutes) and macro security settings in Word 2008

e  Step-by-step instructions to assist you with the most common thesis formatting actions

e Definitions of the Ul Thesis Template Styles

e  Best Practices to help you avoid problems during your document creation and formatting process
e Resources for assistance

What is a template?

A template is a unique Microsoft Word document, which contains predefined content such as styles, formatting, macros, customized
toolbars, text and design elements. When you attach a specific template to a document, the document will then have access to the
items contained within that particular template (e.g., styles, macros, toolbars, etc.).

Many people are unaware that every Microsoft Project Gallery
Word document is based on a template. When B fiecontemfmProject Gentenmmettingse]
presented with the New Document dialog box =) —
(as shown on the right), you are required to mc;eg; -~
select the type of document you would like to Blank Documents
create. If you select Word Document, your b Templates
document will be created based on the Normal Business Cards
template (Normal.dotx in Word 2008). You EE’;;E’:;N forme
also have the option to create a new document Events PowerPaint Presentation Word Document
based on one of the other templates provided. E:Zr:: Essentials
If a new template (such as the Ul Thesis Lataer Sheets
Template) is attached to an existing document, :.T:Lk:i:::frs
the document will then use the Ul Thesis :T;enmmis i _ . .
Template’s styles, content and page layout. It Programs »| Word Notebook Layout  Word Publishing Layout 3
will no longer be attached to the Normal comsianan 1 L
template.
Open Othe Cancel Open
To help you understand the relationship

between your document and your template, Figure 1. Microsoft Word “New Document” dialog box.

here’s an analogy: Think of your document as

your car, and the template as your car’s dashboard. Your car’s dashboard is attached to your car and contains instrumentation and
controls you utilize while driving — the speedometer, odometer, fuel gauge, radio, and various other components. Although you are
accessing and using the components contained on your dashboard, you are never actually opening up the dash to access these
components or controls - rather, you access them from the dashboard where they remained attached. The same is true with a
template — your template (dashboard) will be attached to your document, and you will utilize the toolbars, macros and styles
(speedometer, odometer, radio, etc.) contained within the template. However, you will never actually open the template file itself
and manipulate it by typing into it, pasting text into it, etc. As with your dashboard and your car, your template should be attached
to your document, and should not be opened.

Why should I use templates to format my documents?

Although templates are useful tools for ensuring consistency when formatting your documents, many people are unfamiliar with
styles. As a result they rely on direct formatting to format their documents. By reviewing the information and external resources
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provided in this document, you will attain a basic understanding of template styles and the ability to use them to format your
documents. To aid in this process, we have explained how styles are more advantageous than direct formatting.

Styles Direct Formatting
Time: With styles, you have the ability to format words or With direct formatting, you must touch each and
paragraphs exactly as you want with one click. every word, paragraph and/or page individually to
include any formatting details you would like to
specify.
Consistency: By applying a style to a word or paragraph, you With direct formatting, you must manually apply the
ensure that it is formatted exactly the same as font and any additional paragraph formatting to
others of its type or style. each section. In addition to being time-consuming, it

is also difficult to be consistent with this method.

Effort: When you change a style, you change all words or If you change your mind on formatting you’ve done
paragraphs associated with that style. in several sections of your document, you must
repeat the process for each word or paragraph.

For more information pertaining to styles, go to the Help menu, and search for “Word Styles”.

Getting Started

Before you begin...
Before you begin formatting your thesis documents, you will need to carefully review the information in this section, and obtain the
required items listed below.
1. Bookmark the ITS Thesis and Dissertation website for future reference: http://cs.its.uiowa.edu/sda/index-thesis.shtml
2. Obtain the three required items from the Thesis Template Checklist, which include:
a. Thesis Template Documentation
The Ul Thesis Template for Word 2008 document will assist you with the information you need to format your
documents using the styles provided in the Ul Thesis Template. Step-by-step instructions will help you with the
most common thesis formatting actions.
b. Ul Thesis Template Style Definitions
The Ul Thesis Template Style Definitions provides you with a list of the most common styles contained in the
template, and explains what formatting is applied when the style is selected. It will also assist you with
determining the appropriate style for sections within your document. The Ul Thesis Template Style Definitions can
be found on page 20 of this document.

c. Ul Thesis Template for Windows (http://cs.its.uiowa.edu/sda/thesis-templates.shtml)
The Ul Thesis Template was created to help you format your thesis documents consistently and with ease. Please
refer to the Download the Ul Thesis Template section below for important information pertaining to downloading
and attaching the Ul Thesis Template.

Please note: You should never open the “Ul Thesis Template.dot” file and type directly into it (or paste text directly into it) — doing so
can result in the template no longer functioning as a template, and puts you at risk for incorrectly formatted items and possible
corrupt documents. Please follow the step under “Attach the Ul Thesis Template to your documents” to learn how to correctly attach
the template to your new or existing documents.

Download the Ul Thesis Template

If you have not yet done so, please go to http://cs.its.uiowa.edu/sda/thesis-templates.shtml to download a copy of the template.
Due to differences in the Graduate College formatting requirements and the way Microsoft Word handles formatting, the template
does NOT match the Graduate College requirements 100%. While it is close, everyone will likely need to do some additional manual
formatting to get your thesis in final form.

Please note: These are compressed files, which will need to be unzipped in order to view them after download. To obtain a copy of
Stuffit Expander for this purpose, please go to: http://www.download.com, search for the Stuffit Expander software, and follow their
installation instructions. If you need assistance extracting the zipped files, please contact the ITS Help Desk at 384-4357.
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Attach the Ul Thesis Template to your document(s)
The most important thing to know before you begin formatting your document is how to properly attach the Ul Thesis Template to
your thesis documents. A common mistake is opening the “Ul Thesis Template.dot” file and typing directly within the document (or
copying text from an existing document and pasting it into the template). You should never need to open the “Ul Thesis
Template.dot” file for any reason — doing so can result in the template not functioning properly, and increases the risk for corrupt
files (in other words, you run the risk of experiencing a formatting nightmare). Instead, you will attach the template to your new or
existing documents by following the instructions below.
Please make sure you have downloaded and extracted the Ul Thesis Template.dot file before continuing below. Steps for doing so
can be found in the previous section.
To attach the Ul Thesis Template to your documents: Templates and Add-ins
1. Create a New Folder called Thesis to store your new or existing thesis

documents and the Ul Thesis Template.

Please note: Your template will always be available to you when it is

located in the same folder as your thesis documents. When working on

multiple computers, make sure you copy the entire Thesis folder between Chasaiierm plates anc
Computers, Checked items are currently loaded.

jdoe:Desktop:Thesis:Ul Thesis Template.dot

¥ Automart ly update

2. Copy the Ul Thesis Template.dot file into the new Thesis folder.

Please note: Disregard the “Ul Thesis.doc” document — this is being phased

out and is no longer applicable Launch Microsoft Word 2008.

Launch Microsoft Word 2008.

4. If you have thesis documents that you have already created, open your
thesis document now. Otherwise, create a new Word document. Full pat

w

5. From the Word menu bar, select Tools = Templates and Add-Ins...
In the Templates and Add-ins dialog box, click the Attach button to D
navigate to the Thesis folder. Select the Ul Thesis Template.dot file, and
click the Open button to return to the Templates and Add-ins dialog box.

6. Place a check in the check box next to Automatically update document
styles.

Figure 2. Attach the template to your document.
7. Click OK to attach the template and return to your document. You should now see the list of styles available on the Thesis
Toolbars.
Please note: If a Warning dialog box appears concerning Visual Basic macros, click Open to continue. Please see the
following section pertaining to Visual Basic Macros and Word 2008.
8. Save your document to the Thesis folder.
Please note: If you have already created multiple thesis documents, you will need to follow steps 5 —8 for each document.

As long as you copy your entire Thesis folder between computers, your template will stay attached and you will be able to
access the thesis styles each time you open the document. You are now ready to begin applying styles and formatting your
documents. For information pertaining to the styles contained in the Ul Thesis Template, please refer to the Definition of styles
used within the Ul Thesis Template section of this document.

Visual Basic Macros and Word 2008

Microsoft defines a macro as “a set of computer instructions that you can record and associate with a shortcut key combination or a
macro name. Then, when you press the shortcut key combination or click the macro name, your computer program carries out the
instructions of the macro.” The Ul Thesis Template includes macros which will automatically generate your Preliminary Pages and
Doctoral Abstract for you based on the information you supply to the resulting questions. These macros contain the formatting
needed to meet the Graduate College’s requirements. While the macros contained within the Ul Thesis Template are safe, there is a
potential security risk associated with macros, as a person with malicious intent could create a destructive macro and include it in a
document to spread a virus.
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Word 2008 does not support Visual Basic macros or add-ins containing Visual Basic macros, and for this reason you will be prompted
with the following message when opening a document attached to the Ul Thesis Template:

This file contains Visual Basic macros
i \ .‘ Wisual Basic macros do not work in Office 2008 for Mac. To open
'-\H_ the file and remove the macros, click Open and Remove Macros.

To open the file and keep the macros, click Open

Learn about macros and Office for Mac

(" Open and Remove Macros N'I (" cancel N'I E Open 3

Figure 3. Visual Basic macros message.

When prompted with this message, simply click “Open” or “Open and Remove Macros” to continue to your document. As macro
functionality is not available in Word 2008, the Prelims and DocAbsSeparate buttons on the Ul Thesis Template toolbars will not
function in Word 2008. If you are using Word 2008, please contact the ITS Help Desk at its-helpdesk@uiowa.edu, and request a
copy of the Preliminary Pages and Doctoral Abstract. You can then replace the information in the example document with your own
information (e.g., Thesis Title, your name, thesis supervisor, committee members, etc.). These documents will prevent you from
having to create and format your Preliminary Pages and Doctoral Abstract manually, allowing consistency with the Graduate College
Guidelines. Please note that Microsoft has announced that VBA will be available again in the next major version of Office (Office 14).
For more information about Visual Basic macros and Word 2008, do a search in Microsoft Word’s Help menu for macros or Visual
Basic.

Show / Hide Paragraph Marks 9 , New Line Markers «*, Tabs =—# , and Spaces ¢+**
While working on your documents, we recommend you reveal formatting marks to assist you. To do so, select one of the methods
below:

e Click the Show / Hide marker ﬂ on the standard toolbar, OR

e Press Command + 8 (not on the numpad)

Turn on Word’s Automatic Save Feature
The Automatic Save feature is useful in the instance of system or power failure, but is not a replacement for saving and backing up
your work. Remember to perform regular backups of your work and to save frequently.

1. Select Word = Preferences from the Standard toolbar.
2. Inthe Word Preferences dialog box, click Save.

3. Inthe Save dialog box, set the following:
a. Place a check next to Save AutoRecover info every: x minutes
b. Specify how often you would like the program to save your data and program state in the minutes list.
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Page Setup

Set margins and page number position
The following steps will walk you through setting your margins and page number position. The Header and Footer measurements
control the distance from the edge of the paper to the outer edge of the page numbers. Adjust the Header and Footer settings per

the instructions b

elow to fix your page number position (if needed).

Please note: These steps must be done to any document which was created prior to attaching the template to it.
1. From Word’s menu bar, select Format 2 Document
2. Enter the following numbers/select the following items where appropriate

For Portrait pages:
0 On the Margins tab

=  Top=1.0"
=  Bottom =1.0"
= left=1.5"

= Right=1.0"
= Gutter=0"
= Gutter Position = Left
=  From Edge set
e Header=0.5"
e Footer=0.5"
= Select Apply to Whole Document
(skip this step if you wish to only
change the margins in the current
section of your document)
= C(Click OK
For Landscape Pages

Document

Margins = Layout |

Preview

=

Top:

Bottom: 1" B e
Left: 1.5" [+ e
Right 1 B ::
Gutter: _D" ij —

From edge )

Footer: |0.5"

(4

[ Mirrer margins

( Default... \ r Page Setup... \

([ Cancel )

Figure 4. Set page margins.

0 From the Document dialog box, click the Page Setup... button, select the Landscape orientation, then click
OK to save your changes and return to the Document dialog box.

0 On the Margins tab

= Top=1.5"

=  Bottom=1.0"
= Left=1.0"

=  Right=1.0"

= Gutter=0"

=  From Edge set
e Header =0.5"
e Footer=0.5"

= Select Apply to Whole Document (skip this step if you wish to only change the margins in the

current section of your document)
= Click OK

Insert Page Numbers
1. Choose Insert = Page Numbers

2. InthePa
a.
b.
c.

ge Numbers dialog box, set the following:

From the Position drop-down menu, select Top of Page.

From the Alignment drop-down menu, select Right.

Place a check in the check box next to Show number on

first page
Click OK to save your changes and return to your
document.

Ul Thesis Template for Word 2008 ver 2.1
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Position: Preview
[ Top of page (Header) )
Alignment:

[Right )

E Show number on first page

[ Format... ) [ Cancel )

Figure 5. Insert page numbers (steps 2a — 2d).
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Change Starting Page Number Page Number Format
1. Choose Insert > Page Numbers )
2. From the Page Numbers dialog box, click Format... Number format: Q2 +
3. In Page Number Format dialog box, select Start At: and select the page [ Include chapter number
number you want for the first page of your document. e sl B
Click OK to save the changes and return to the Page Numbers dialog box. T :

5. Click OK to save the changes and return to your document.
Examples: 1-1, 1-A
Start a New Line, not a New Paragraph Page numbering
There are times when you may wish to force the text from one line to the next

line without starting a new paragraph. An example of this would be chapter —
headings (as shown in the example below). You will want to keep these lines as @ sorcar 1 . 8
one paragraph, so they stay on the same page after applying the Heading 1 style,
and so they appear as one entry in your Table of Contents. Another example
where you might use this is in a quote or poem (where you wish to keep the lines
together correctly at the top and bottom of a page).

O Continue from previous section

I:-Ca.nceljl ( 0K )

Figure 6. Change starting page number.
1. If your formatting marks are not visible, turn on the Show all nonprinting characters by following the steps in the section
above.

2. Ifthereis currently a paragraph mark between the first and second lines, delete this now (place your cursor at the
beginning of the second line, and hit the Backspace key on your keyboard to bring the two lines together).

3. Tocreatea r?ew line, place your cursor immediately in front of the text you wish to appear on CHAPTER-1+
the second line.

4. Hold down the Shift key and press the Enter key. INTRODUCTIONY|

5. This will enter a New Line character (as shown at the end of the CHAPTER 1 line to the right) Figure 7. New line.

Landscape Pages with Portrait Page Numbers

Within your thesis document, you may have pages which require landscape orientation, such as pages that contain wide tables or
images. Simply modifying the page orientation will not correct the page numbering position for you. The easiest way to insert page
numbers into your landscape pages is to download our LandscapePages.docx file to your thesis folder from our website
(http://cs.its.uiowa.edu/sda/documents/LandscapePages.doc), then follow the instructions within the document. The Ul Thesis
Template does not need to be attached to the LandscapePages.doc file in order to use this method.

Use the Template to format your document

Apply Styles to your paragraphs

The template will allow you to incorporate consistent formatting to your thesis documents with ease. However, simply attaching
the template will not automatically format your document for you. You will need to go through and apply the appropriate styles to
the content within your document. For your convenience, we have included definitions of the styles used within this template,
which will assist you in determining the appropriate Style to paragraphs within your documents. To view these definitions, please
see the Definition of styles used within the Ul Thesis Template section of this document.

To apply a specific style to individual paragraphs
1. Place your cursor in the paragraph where you would like to apply the style.
2. From the Ul Thesis Toolbars, locate the appropriate style and click the style button.
To apply a specific style to multiple paragraphs
For multiple paragraphs with of the same style, you can quickly apply the style formatting to all of the paragraphs (rather than

clicking on each paragraph to apply the appropriate style) by following the steps below:
1. Place your cursor at the beginning of the first paragraph.

2. Scroll down the page until you locate the next paragraph style change (e.g., if you are applying the “Normal” style to
multiple paragraphs, you would scroll down until you find a bulleted/numbered list, heading, quote, etc.).

3. Hold down the Shift key, and then click at the end of the last paragraph of the same style (doing so will select all paragraphs
between step A and step C).

4. From the Ul Thesis Toolbars, locate the appropriate style and click the style button.
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Replacing the Ul Thesis Template with a Modified or New Version

If you have requested a customized template from ITS, or would like to replace your existing template with a newer version of the
template, please follow the steps below.

Please note: If you have manually changed the default font or changed or added any styles to your existing template, you may want
to save a copy of your old template under a new name to allow you refer back to the modified styles.

1.
2.

Open your thesis document in Microsoft Word 2008.
Determine where your template is stored on your computer:
a) Select Tools = Templates and Add-ins...

b) From the Templates and Add-ins dialog box, write down the entire path that displays in the Document Template
field.

Close any open documents.
Delete any previous copies of the Ul Thesis Template.dot file that you have on your computer.

a) Search your local drives, external hard drives (including USB Keys) and network drives (where you may have saved
a copy of the template), and delete all copies of the Ul Thesis Template.dot. This includes the copy located in the
path in step 2b above.

Download and unzip the new template file from the ITS website or your email message (if a customized copy of the
template was emailed to you from ITS).

Copy the Ul Thesis Template.dot file, and paste it into your thesis folder (which should be the path noted in step 2d above).
Reattach and update each of your thesis documents to the new template:
a) From the Word menu bar, select Tools = Templates and Add-Ins...

b) Inthe Templates and Add-ins dialog box, click the Attach button to navigate to the Thesis folder. Select the Ul
Thesis Template.dot file, and click the Open button to return to the Templates and Add-ins dialog box.

c) Place a check in the check box next to Automatically update document styles.

d) Click OK to attach the template and return to your document. You should now see the list of styles available on
the Thesis Toolbars

All previously applied styles should now be updated — scroll through and spot check to verify.

Change the Default Font of the Ul Thesis Template

The Ul Thesis Template defaults to Times New Roman font. This font was selected as the default because it requires the least
amount of manual formatting changes. If you would like to change the default font for the Ul Thesis Template, please follow the
steps below:

1.

. . (5] ) Formatting Palette Q
Open the Ul The;15 Template.dot file. ' ' ' 5N % =
Please note: This should be the only time you will need to actually open the template file.

> Font

2. From the Formatting Palette, expand the Styles section. ¥ Styles
Please note: If your Formatting Palette is not visable, select View = Formatting Palette I (i) X z
from the Standard toolbar. — T
3. From the Pick style to apply section, scroll down to locate the Normal style. Hover your Jesntes cm el
mouse over the Normal style (to be presented with the drop-down arrow), then click and e R -
select Modify Style to modify the style’s font. M ﬂ
4. If selected remove the check next to Add to template. - e ﬂ
5. Click the OK button to save your changes. r\:mm ﬂ
6. Close your file, and click Yes to save changes. : Mrm_ul = ﬂ .
*To determine which font styles and sizes are acceptable to the Graduate College, please refer to B il

the Graduate College Thesis Manual, or contact the Graduate College directly.

List | Available styles -
P Alignment and Spacing
P Bullets and Numbering
b Borders and Shading

p Document Margins

Figure 8. Formatting Palette.

Ul Thesis Template for Word 2008 ver 2.1 Spring 2010
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Footnotes

Insert a Footnote
To insert a footnote in your document, follow the steps below:

1. Place your cursor in the location where you wish to add the first footnote.
2. Select Insert 2 Footnote from the Standard toolbar.
3. From the Footnote and Endnote dialog box, select the type of note you wish to add (either footnote or endnote).
4. Click OK to save your changes and return to your document.
Modify the Footnote Separator Line and/or Foonotes sy Egotnotes B Close W
Footnote Continuation Separator Line AllESetats wa City: University of owa, 2009) 23,
A common first deposit comment refers to the location of the —  ‘[Factiots Continuation SepaRtor
footnote separator lines and continuation notices — these need Footnate Continuation Notice 1
to line up with the left margin of the document. If you need to 4
modify your footnote separator and/or continuation separator o
line, please follow the steps below: = e O ar
1. Select View - Draft from the Standard toolbar to E=EEIB) outcvies feculi| mAzqeslinis] z
change your document view. Figure 9. Footnote pane.
2. Select View => Footnotes from the Standard toolbar — the Footnotes will now be displayed in a separate pane at the
bottom of your document.
3. Inthe Footnotes pane (the lower half of your window), select the type of separator line you would like to modify from the
Footnotes: drop-down menu.
Please note: To change the separator that appears between the document text and notes, click Footnote Separator. To
change the separator for notes that continue from the previous page, click Footnote Continuation Separator.
4. To left-align a separator line, place your cursor at the beginning of the separator line and hit the Backspace key on your
keyboard to remove the extra space.
5. Repeat steps 3-4 for each separator line you wish to adjust.
6. Select View => Print Layout to return to your previous view and verify the changes.

Captions, Notes and Sources

In addition to including styles for figures and tables (see Figures
10 and 11) there are also a few other features and styles
pertaining to your figures and tables that will be helpful while
formatting your documents. Please review the additional
information below pertaining to figures and tables.

Insert a Figure or Table Caption

Figures/Images ¥ Tahles Tables v| Equation Para Refer

Figure Image Para I}) Table Para s

Note/Source Line Mote /Source No Line

) MNote/Source Line
MNote /Source No Line

Table All Lines

Earlier in this document, we explained the benefits of using

Lines - 1

styles to format your paragraphs, such as saving you time and Table Box

i i . i Lines - 3
effort, and.ensurlng consistency) A.nother way to’save you time Table Tag Bottom Lines
and effort is to take advantage of Microsoft Word’s Insert :
Caption feature. Inserting your figure and table captions in the Caption Lines - 1
manner explalnv.ad belqw will allow you to automat!cally Figure 10, Style used fo format Gheres
generate your List of Figures and List of Tables, saving you from figures
manually typing your lists. Select the manner which is most Caption

appropriate for your document below, then follow the steps for
inserting a figure or table caption.

If you have not typed your caption description :

Figure 11. Style used to format

tables.

1. Insert a new paragraph before or after your figure/table where you would like to insert your caption.

Please note: Do not select the paragraph mark.

Place your cursor on the new paragraph line (added in step 1).

Ul Thesis Template for Word 2008 ver 2.1

Select Insert = Caption from the Standard toolbar (or click the Insert Caption style from the Ul Thesis Template toolbar).
In the Caption dialog box, select the appropriate label for your caption (Figure or Table).

Spring 2010



12
5. Click OK to close the dialog box and return to your document.

6. Add your caption description after the caption label.

If you have already typed your caption description:
1. Place your cursor at the beginning of the line containing your caption.
Note: Do not highlight or select any of your caption text, label or numbering.

If you have already manually typed your caption label and number (e.g., Table 1), delete them now.
Select Insert = Caption from the Standard toolbar (or click the Insert Caption style from the Ul Thesis Template toolbar).
In the Caption dialog box, select the appropriate label for your caption (Figure or Table).

L NN

Click OK to close the dialog box and return to your document.
3. Add your caption description after the caption label.

Please note: The Caption can NOT be inside the figure or table — the caption must exist in a paragraph of it’s own and match the font
of the thesis text.

Modify Caption Number for a Figure or Table

If you plan to number your figure or table captions to include the chapter number (e.g., Table 3-1, Table 3-2, Table 3-3, etc.), you will
need to do a little manual formatting to implement this. There are two methods for doing so, depending on how you have your
document(s) set up. Select the manner in which you have your document laid out below, then follow the steps for modifying the
caption number.

If each chapter of your thesis is contained in a separate document, follow these steps:
1. Insert the caption for your first figure or table (see “Insert Captions for Figures or Tables” for instructions). The caption
should display as “Figure 1” or “Table 1”.

2. Arrow back to place your cursor directly before the “1” (when
moving across the “1”, you will see that it displays with a grey box
highlighting it, as shown in Figure 12. This tells you that captionis  Figure 12. Step 2
linked to the document, and will allow you to create your List of
Figures or List of Tables with ease).

3. Type the chapter number and separator before the “1” (e.g., if this is the first image in Chapter 3, you would insert
“3-” immediately before the caption number).

Table[l. Impactofntervention mniral conmuntties

4. Your caption should now read as “Figure 3-1” or “Table 3-1” (as

Table3-1. Impact ofinterventionin miral cormrmmities
shown in Figure 13).

Figure 13. Modified figure caption after including chapter

5. Repeat steps 1-4 for the remaining Figures or Tables in your designator.

document.

Please note: Do not delete or modify the caption number that is inserted by the “Insert Caption” feature (e.g., the “1” in step #1
above). If you would like to change the starting caption number, please follow the steps below to do so.

If all of your chapters are combined into one document, please follow these steps:
When all of your chapters are contained in one document, you will find that captions will begin at 1 for the first caption, and
continue in ascending order for each caption that follows (e.g., Table 1, Table 2, Table 3, etc.), regardless of the chapter in which
they reside. If you would like to include the chapter number in the caption, and would like to restart the caption numbering in each
chapter (e.g., Table 1-1, Table 1-2, Table 2-1, Table 2-2, etc.), you will need to follow the steps below to do so.
Please note: Do not use the “Include Chapter Number” option within the Insert Caption dialog box in Word — you will need to follow
the steps below.

1. Insert the captions for all figures or tables for your first chapter

as you normally would (see “Insert Captions for Figures or
Tables” for instructions). Figure 14. Step 2 (first figure in Chapter 2).

Figure 6. Factors contnibuting to risingtest scores

2. Within Chapter 2, find your first figure or table, and insert the caption (if you have not already done so), as shown in Figure
16..

3. Inthe Ul Thesis 6 — Misc Buttons toolbar, click

H SEQR \*FARABIC}. Fact tributing to rsing test
the View All Field Codes button —you will see igure ke o L

something similar to Figure 15. Field code for first figure in Chapter 2.

Ul Thesis Template for Word 2008 ver 2.1 Spring 2010
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{ SEQ Figure \* ARABIC } where your Caption should appear
Please note: If the Ul Thesis 6 — Misc Buttons toolbar is not displayed, select View = Toolbars and select Ul Thesis 6 — Misc
Buttons from the resulting menu.
4. Modify your field SEQ so that it reads as
follows, which will reset the sequence

number to 1: Figure { SEQ Figure ‘v 1 VF ARABIC}. Factors contnbutingto nsing test scores
{ SEQ Figure \r 1 \* ARABIC } Figure 16. Modified SEQ code to reset the sequence number to “1”.

Please note: If you would like to start your numbering at a number other than 1, replace the “1” with the appropriate

number.

5. When finished, click the View All Field Codes button from the Ul Thesis 6 — Mis Buttons toolbar to deselect it and switch
back to your document (you should no longer see the field codes). At this point, your caption will appear to be unchanged
—you will need to update the field to reflect the changes (continue with the steps below).

6. Press Command + A to select the entire document.

7. Click the Update Selected Fields button from the Ul Thesis 6 — Misc Buttons toolbar to update the fields — your caption
number should now display as 1, and each caption that follows will continue numbering in ascending order.

Repeat steps 2 — 7 for each chapter in your document.

9. When you have finished renumbering each chapter of your
document, you can then type the chapter number and separator
directly before each caption number (e.g., for Chapter 2, you can Figure 17. Renumbered figure caption after updating field
insert “2-“ prior to each caption number, so it will then display as 2-  codes and adding chapter designator.

1, 2-2, 2-3, etc.).

Figure 2-1. Factors contnbuting to nsing test scores

Modify Captions for Figures or Tables within an Appendix

You may choose to include your figures or tables within an appendix (rather within the individual chapters). To modify the figure or
table captions to reflect the Appendix number and separator (e.g., for Appendix B, it would appear as Table B-1, Table B-2, etc.),
please follow the appropriate steps below (depending on the layout of your document(s)).

If each appendix is included in a separate document, follow the steps below:
1. Insert the caption for your first figure or table within your Appendix (see “Insert Captions for Figures or Tables” for
instructions). The caption should display as “Figure 1” or “Table 1”.

2. Arrow back to place your cursor directly before the “1” (when
moving across the “1”, you will see that it displays with a grey box
highlighting it — this tells you that caption is linked to the Figure 18. Step 2.

document, and will allow you to create your List of Figures or List of Tables with ease).

Figure 1. Cormununity Concems —Flood Preparation

3. Type the appendix letter and separator before the “1” (e.g., if this is the first image in Appendix B, you would insert “B-"
immediately before the caption number).

4. Your caption should now read as “Figure B-1” or “Table B-1". Figure B-1. Community Concems—Flood Preparation
5. Repeat steps 1-4 for the remaining Figures or Tables in your - — - - - -
appendix Figure 19. Modified figure caption after including appendix

letter and separator.

If your appendix and thesis chapters are all included in one document, follow the steps below:

When all of your chapters and appendices are contained in one document, you will find that captions will begin at 1 for the first

caption, and continue in ascending order for each caption that follows (e.g., Table 1, Table 2, Table 3, etc.), regardless of the chapter

or appendices in which they reside. If you would like to include the appendix number in the caption, and would like to restart the

caption numbering in each appendix (e.g., Table A-1, Table A-2, Table B-1, Table B-2, etc.), you will need to

follow the steps below to do so.
1. Within your first appendix, find your first figure or table, and insert Table24. Impact of flood damage by conmmrnty

the caption (if you have not already done so). Figure 20. Step 1.

2. Inthe Ul Thesis 6 — Misc Buttons toolbar, click
the View All Field Codes button —you will see

something similar to . _
{ SEQ Table \* ARABIC } where your Caption Table { SEQ Table'\* ARABICY. Impactofflooddamage by comrmraty
should appear. Figure 21. Field code for first figure in Appendix A.

Ul Thesis Template for Word 2008 ver 2.1 Spring 2010



Add a Note or Source to a Table or Figure

To add a Note or Source to a Table or Figure, please follow the steps below: Figures/Images v| Tables
1. If you have not yet done so, insert your table or figure, and the caption. Figure Imege Para
2. Place your cursor on a new line after your table/figure/caption.
i . MNote /Source Line
3. Select Figures/Images or Tables from the Ul Thesis Toolbar to reveal the drop-down
menu. Note/Source No Line
4. From the resulting menu, select Note/Source Line or Note/Source No Line, based on your Lines - 1
preferences. lires =3
(To understand the difference between Note/Source Line and Note/Source No Line,
please refer to the Definition of styles used within the Ul Thesis Template section of this Caption
document.)
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Please note: If the Ul Thesis 6 — Misc Buttons toolbar is not displayed, select View = Toolbars and select Ul Thesis 6 — Misc
Buttons from the resulting menu.
Modify your field SEQ so that it reads as
follows: { SEQ Table \r 1 \* ARABIC }
This will reset the sequence number to 1. Figure 22. Modified SEQ code to reset the sequence number to “1”.
Please note: If you would like to start your numbering at a number other than 1, replace the “1” with the appropriate
number.
When finished, click the View All Field Codes button from the Ul Thesis 6 — Mis Buttons toolbar to deselect it and switch
back to your document (you should no longer see the field codes). At this point, your caption will appear to be unchanged
—you will need to update the field to reflect the changes (continue with the steps below).

Table { 3EQ Table'r 1'* ARABIC}. Impactof flood damage by conmrmmmty

Press Command + A to select the entire document.

Click the Update Selected Fields button from the Ul Thesis 6 — Misc Buttons toolbar to update the fields — you caption
number should now display as 1, and each caption that follows will continue numbering in ascending order.

Repeat steps 1 — 6 for each appendix in your document.

When you have finished renumbering the captions within each Table A1, Impact of flood damage by conmmuwity

appendix, you can then type the appendix number and separator
directly before each caption number (e.g., for Appendix A, you can Figure 23. Renumbered figure caption after updating
insert “A-“ prior to each caption number, so it will then display as A- field codes and adding appendix letter.

1, A-2, A-3, etc.).

Figure 24. Steps 2 and 3 (select

Please note: Make sure you have at least three single (12pt) spaced lines between the note/source Note/Source to add a note or
and the text of your thesis. source to your table or figure).

Preliminary Pages

As explained in the previous Visual Basic Macros and Word 2008 section of this document, Word 2008 does not support Visual Basic
macros, and therefore the Prelims and DocAbsSeparate buttons will not function in this version of Word. Please contact the ITS Help
Desk at its-helpdesk@uiowa.edu to request a copy of the Preliminary Pages and/or Doctoral Abstract documents.

Delete an unwanted page within the Preliminary Pages
You may find that after creating your Preliminary Pages, you no longer need a page you inserted. In order to remove the page
without modifying the section breaks and page numbering that is built into the macro, please follow the steps below:

1.

vk W

6.

From the View tab, change your document view to Draft.

Select the text you wish to delete (by dragging the mouse to highlight the text, or method of your choice).
Press the Delete key on the keyboard.

A flashing black line (also referred to as a mouse I-beam) appears on top of the Section Break (Next Page) line.
Press the Delete key on the keyboard.

Save the revised document.

Please note: We recommend verifying the deletion of the desired page(s) by returning to the Print Layout view.

Ul Thesis Template for Word 2008 ver 2.1 Spring 2010
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Add an additional supervisor to Prelims and Doctoral Abstract
If you have more than one Thesis Supervisor, you will need to add additional lines to your Preliminary Pages and Doctoral Abstract.
In order to do this, you will need to follow the steps below:

1.

2.
3.
4

Change Thesis Supervisor: to Thesis Supervisors:

Place your cursor on the Thesis Supervisors: line

Scroll up within your document so the Thesis Supervisors: line is at the top of the screen (by the ruler).

If your paragraph markers and line breaks are not displayed, please click the Show all nonprinting characters button on the
toolbar

You should see a new line marker ( 4 ) at the end of the Thesis Supervisors: line. If you do not see the new line marker,
you can enter one now by pressing the Shift key and Enter key simultaneously.

Type the title and name of your second Thesis Supervisor on the line directly below the first supervisor.

Please note: When following these steps, you will initially place the supervisor with the longest name and title on the first
line, and the one with the shorter name and title on the second line. This is only temporary — you can place them in the
order that is most appropriate in step 12 below.

With your cursor still on the Thesis Supervisor line, make a note of the starting measure of the first line (a), the ending
measure of the first line (b) and the starting measure for the first supervisor’s title (c).

Please see the image below for a visual.

Ple i H = o FirstLime1 e [ﬂ & | o= ['_@J 100% MG

Tables Columns Show MNavigation Gallery Toolbox Foom  Help

Mew Open Save Print Undo] Indent marker

il E-INIRNER

& O O Farmatting Palette 2 Ele uwick Tables | Charts | SmartArt Graphics | WordArt

-|---1|--|---2|------3|---|----’-|---|--;|---|---¢.‘---|---
Left Align Button t ' |:;3] ' ' ib) ' ' ' ' ic) ' '
v Alignment\gnd Spacing Hanging hesis- Supervisor: fussociate Professor-Michael Okoro
- = = Professor-Elisabeth Brown T
Harizontal = . = = Indent
- — marker
- | Line spacing — -

Orlentation: (A ||

10.
11.

12.

13.

Figure 25. Steps 1-7.

Click and drag the Hanging Indent marker on the ruler to the starting measure point of the first Supervisor’s title (b) — the
triangle only, not the square below the triangle..
Hint: For more precise control, hold down the Alt key while dragging.

Click and drag the First Line Indent marker on the ruler to the starting measure point of the first line (a).
Click the Left Align button to align the text to the left.

Replace the spaces after Thesis Supervisors: with a tab in order to line up both names.
Hint: Place your cursor immediately before the first Supervisor’s name, and hit the Delete button twice to remove the two
spaces. Then, hit the Tab key to move the first Supervisor over to line up with the second supervisor.

If needed, change the order of the supervisors by select and drag, or cut and paste.

Please see the image below for a visual.
i [ 100% [+ (@)

Tahles Columns Hanging Indent allery Toolbox Foom  Help
uick Tables | marker rt Graphics | WordArt

First Line Indent
marker

rT—— R T T O e e

iﬂ]lT (b} (c)
hesis-Supervisor:-#rofessor-Elisabeth-Brown-+
Associate Professor-Michael Okore

Figure 26. Appearance after steps 8-12.
PhD Candidates: Copy and paste these fixed lines into your prelim pages and doctoral abstract document.
e Besureinclude the paragraph mark by the second advisors name when you copy, and

e Do NOT include the section break or last paragraph mark on the page when you copy and paste.
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Table of Contents / List of Figures / List of Tables

Insert Table of Contents

This should be done at the end of each document that is
part of your thesis, rather than within the preliminary
pages. The Table of Contents created in the preliminary
pages is simply a placeholder — you will later update,
unlink and copy the Table of Contents from your main
document(s), and paste them in the appropriate location
in the preliminary pages.

1. Open your thesis document (not your preliminary
pages document).

2. Scroll to the end of the document*

Select Insert - Break - Page Break from the
Standard toolbar.

16

Index and Tables

["index

Table of Contents

Table of Figures

Table of Authorities |

Formats:

From template
Traditional
Classic
Contempaorary
Maodern

Formal
Simple

Show levels: 3 @

E Show page numbers

Preview

Heading 1
Heading 2 ..

Heading2 .

E Right align page numbers

\ Cancel )

(. Options... )
| Modify... )

Tab leader: [ ... | :i

Figure 27. Steps 3 —6.

Select Insert = Index and Tables... from the Standard toolbar.
In the Index and Tables dialog box, click on the Table of Contents tab (at the top).

In the Table of Contents dialog box, set the following:
a.
b.

C.
d.
e.

Select From template from the Formats: choices

Select the number of levels you wish to show from the Show levels: field (please refer to the Graduate College
Thesis Manual to determine the minimum number of levels allowed).

Check Show page numbers
Check Right align page numbers

Choose the Tab leader you would like to use

Click OK to save your changes and generate your Table of Contents.
*We encourage you to insert your Table of Contents (TOC) at the end of your document, rather the beginning. This will ensure that
your page numbering is correct when you copy and paste the TOC into your preliminary pages document.

Insert List of Figures or List of Tables
This should be done at the end of each document that is part of your thesis, rather than within the preliminary pages. The List of
Figures/List of Tables created in the preliminary pages is simply a placeholder — you will later update, unlink and copy your lists from
your main document(s), and paste them in the appropriate location in the preliminary pages
Please note: This will only work if you have used the Insert Caption feature (located within the Ul Thesis toolbar, or under the
References tab within the Captions group). For information pertaining to captions, please see the Insert Figure/Table Captions
section of this document.

1. Open your thesis document (not the Prelim Pages).

2. Scroll to the end of the document*
3. Select Insert = Index and Tables
4,

In the Index and Tables dialog box, click on the
Table of Figures tab (at the top)

5. Inthe Table of Figures dialog box, set the following:

a.

o ® 0 oo

Select appropriate label type from the
Caption label: choices

Select From template from the Formats:
choices

Check Include label and number
Check Show page numbers
Check Right align page numbers

Choose the Tab leader you would like to use

Index and Tables

[ Index

Table of Contents

Table of Figures

Table of Authorities

1

Caption label:

Equation
g
Table -

Formats

From template
Classic
Distinctive

Centered
Formal

a Include label and numbar

E Show page numbers

Preview

Figure 1: Text lﬂ
Figure 2: Text 3
[T Tl 0 RN -
FigUre 4: Textu. . ovverernrenenssserssnesrennennens 7
Figure 5: Textu. . eoverernrenersssersneerennenss 10
.
v

E{ Right align page numbers

Cancel )

Options... )
Modify... )

Tab leader: [ ... | :]

Figure 28. Options for step 5.

Click OK to save your changes and generate your List of Figures or List of Tables

Ul Thesis Template for Word 2008 ver 2.1
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Update all lists (Table of Contents, List of Figures or List of Tables)
If you have made changes to your document after creating your Table of Contents, List of Figures and/or List of Tables (e.g., modified
caption name or chapter title, or added additional content which will modify the page numbering) , you can reflect these changes by
updating all of the fields within your document.
1. Click to the left of the list you wish to update to select the entire list (the list should be grey, indicating that it is linked)
2. Click the Update Selected Fields button from the Ul Thesis 6 — Misc Buttons toolbar to update the fields.

3. If prompted to update the page numbers only, or update the entire table, select Update entire table, and click OK to return
to your document.

4. Repeat these steps for each list in your document (e.g., Table of Contents, List of Figures and List of Tables)

Add your Table of Contents (TOC), List of Figures or List of Tables to your Preliminary Pages

The information contained in the next two sections should be done in sequential order from the computer you plan to print from or
create an electronic copy for submission (PDF). Changing to a different computer or printer may modify the page numbers and page
breaks, as the number of characters per line and lines per page are governed by the default printer for that document.

Update your Table of Contents, List of Figures or List Update Table of Contents
of Tables
1. Click to the left of the first line of the Table of Word is updating the table of contents. Select one of the following options:

Contents/List of Tables/List of Figures to select the
entire list (the entire table should appear to be
highlighted in grey)

O Update page numbers only
%) Update entire table

2. Click the Update Selected Fields button from the 'r: Cancel \' ( oK )
Ul Thesis 6 — Misc Buttons toolbar to update the
fields. Figure 29. Step 1 (Update Table of Contents/List of Figures/List of Tables).
3. Select Update the entire table
4. Click OK.

Once you have updated your tables, you will then need to follow the steps below in order to place them in your Preliminary Pages
document.

Unlink the Table of Contents, List of Figures or List of Tables, then copy to your Preliminary Pages
Please note: Prior to following these steps, make sure you have followed the steps for updating your tables in the previous section to
update your lists.
1. Click to the left of the first line of your Table of Contents/List of Tables/List of Figures to select the entire table (the entire
table should appear to be highlighted in grey)
2. Click the Unlink Selected Fields button from the Ul Thesis 6 — Misc Buttons toolbar. Your table should no longer be
“linked” to the document (e.g., when you click within the list of items, they should no longer appear to be highlighted in

grey).

3. With the entire list still selected, select Edit = Copy (or Command + C) to copy the text.

4. Select Edit = Undo (or Command + Z) to undo the action (essentially re-linking the table).

5. Save your document (the text you copied will still be located on your Clipboard).

6. Open your Preliminary Pages document.

7. Scroll to the location where you wish to insert your Table of Contents, List of Figures or List of Tables, and click your mouse
to position your cursor.

8. Select Edit = Paste (or Command + V) to paste the text from your main document into the Preliminary Pages.

9. Click in front of the first Heading 2 (your first order subdivision/subheading) in each chapter and press Enter on your
keyboard to insert a single blank line after the chapter title (Major Division Heading), as required by the Graduate College.

Create one electronic file from multiple files

Beginning with the Fall 2009 semester, all master’s theses and doctoral dissertations must be submitted to the Graduate College in
electronic format (with the exception of MFA theses). We recommend you keep your preliminary pages in a document separate
from the main body of your thesis. Additionally, if your document contains many figures or tables, we also encourage you to save
each chapter as a separate Word document, as the file can become cumbersome the larger it becomes. You can still create one
electronic file while keeping your Word documents separate, and this can be done using Adobe Acrobat Professional or the PDF
Conversion Tool on the ETD website.

Ul Thesis Template for Word 2008 ver 2.1 Spring 2010
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For assistance or additional information pertaining to file conversion for ETD, please see the Graduate College’s ETD website:
http://www.grad.uiowa.edu/theses-and-dissertations/etds.

Troubleshooting

I no longer see the Ul Thesis Template toolbars and/or styles

If you open your thesis document and you the Ul Thesis Template toolbars and/or styles no longer appear, it is likely that the Ul
Thesis Template is no longer attached to your thesis document. This can result if the document you accessed is not located within
the folder containing the Ul Thesis Template.dot file, or you have not properly attached the template to your document. If you are
working between several computers, make sure you copy the entire folder containing your thesis documents between computers.
In order to access the Ul Thesis Template styles again, you will need to re-attach the template to your document(s). Please refer to
the Getting Started section for instructions.

I can’t print my Figure
If you have created Drawing Objects within Word, and you are unable to print them, please follow the steps below.

1.

2.
3.
4

Select Word > Preferences from the Standard toolbar.

Click Print (under the Output and Sharing section).

From the Print dialog box, place a check next to Drawing objects (in the Include with document section).
Click OK to save your changes

I can’t view my Figure or Equation in my document — instead, | have an outline box where it should

appear
1.

2.
3.

4.

Select Word = Preferences from the Standard toolbar.
Click View (under the Authoring and Proofing Tools section)
From the View dialog box, set the following in the Show section:
a) Place a check next to Drawings
b) Remove the check next to Image placeholders.
Click OK to save your changes

Only the bottom part of my Figure or Equation appears on my screen or when | print my document

1.
2.

Click on the Figure or Equation to select it.

From the Ul Thesis Template toolbar, click on the Figure/Image Para style (for figures), or Equation Para style (for
equations).

If you are still unable to view or print your equations, please see | can’t print my Figure or Equation and | can’t view my
Figure or Equation in my document section of this document.
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Thesis Formatting Best Practices

The thesis process can seem very overwhelming as you begin —there are many deadlines to meet, guidelines to remember and
processes to learn. However, we have provided you with some “Best Practices” in an effort to at least make the formatting process
as straightforward as possible.
1. Never, ever open the Ul Thesis Template.dot file. Remember to attach the template to your new and existing documents,
as explained in this document.

2. Save your documents often. There is nothing worse than spending a significant amount of time typing or formatting your
document, and then have your application crash on you or experience a power outage. When working on your documents,
try to remember to save every 15 minutes or so - if your computer crashes while you’re working, you’re only out 15
minutes of work (rather than 2 or 3 hours).

3. Make backup copies of your documents on a regular basis, and store them in multiple locations. Save a copy to a USB key
or external hard drive. E-mail a copy to your personal email account (and CC: a friend or family member as welll). Use
Files@lowa (http://its.uiowa.edu/support/files/) to save a copy, which can be accessed from on or off campus. In the event
that your hard drive dies, or worse — you experience a natural disaster, such as a flood, hurricane or fire — your documents
will be safe if you have emailed a copy to a friend or saved a copy to your network drive.

4. When working on multiple computers, copy the entire Thesis folder between locations. This will allow your documents to
stay attached to the Ul Thesis Template.

5. Copy files to your local workstation before you begin. Working on files located on a USB key or external hard drive can be
cumbersome, especially if you have multiple tables or images contained in your document. Before you begin, copy the
Thesis folder to your workstation and then open you’re your documents. When you’re finished, make sure you save the
files and copy them back to your USB key or external hard drive.

6. Keep your Preliminary Pages separate from the main body of your thesis. The section breaks and page numbering styles
included in the Preliminary Pages can result in incorrect numbering location and style for the body of your thesis if these
documents are combined. If you need to submit an electronic copy for any reason, you can create a PDF from multiple
Word documents and avoid page numbering issues. Please see the Create one electronic file from multiple files section for
instructions.

7. If your thesis contains many figures or tables, save each chapter as a separate Word document. Working with documents
which contain multiple figures or tables can result in a large file size. As a result, the file can become difficult to work with,
and also runs the risk of becoming corrupt. You can later create a single PDF from multiple files by following the steps
under the Create one electronic file from multiple files section.
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Definition of styles used within the Ul Thesis Template
The Ul Thesis Template includes a number of “styles” which you will need to apply to the appropriate paragraphs within your
document, and these styles are available via the Add-Ins tab after you have properly attached the template to your document(s).

Below, you will find definitions of these “styles”, including an explanation of what formatting is applied when the style is selected. It

will also assist you with determining the appropriate style for sections within your document.

Ul Thesis Template Style Definitions

Ul Thesis Template
Style Name

Style is used for...

Normal

Normal No Indent

Normal Indented

Heading 1

Heading 1 No Page Break

Heading 1 Before Heading
2

Heading 2
Heading 3
Heading 4
Heading 5
Heading 6

Insert Caption

Caption Style

Insert Foot/End Note
Tables Button
Table Para

Table Top Bottom Lines

Table All Lines

Table Boxed

Figures/Images Button

The text within the body of the thesis. Provides a true 2-to-1 ratio required by Graduate
College.

Used when no indentation is necessary and 'Normal' style is needed.
Used primarily for bulleted/numbered lists and paragraphs following bloke quotes.

Indents left and right margins 0.5" while double-spacing
(24 pt) the paragraph. Provides the required 2-to-1 ratio.

Major Division Heading - used for Chapter titles, References, List of Abbreviations, and
Bibliography headings.

Major Division Heading - used for Appendix when on their own page. Must enter manual
page break before it.

Major Division Heading - Used for Chapter title that is IMMEDIATELY followed by a
Heading 2. To fix spacing between the 2 headings.

First-order Subdivision/Subheading (Grad College Terminology).
Second-order Subdivision/Subheading (Grad College Terminology).
Third-order Subdivision/Subheading (Grad College Terminology)
Fourth-order Subdivision/Subheading (Grad College Terminology).
Fifth-order Subdivision/Subheading (Grad College Terminology)

Used to insert Table and/or Figure captions. MS Word uses the Caption style to build the
List of Tables and/or List of Figures.

Formats Table and/or Figure captions. MS Word uses the Caption style to build the List of
Tables and/or List of Figures. Use Insert Caption to get correct numbering.

Inserts footnote/endnote reference mark, enabling entry of footnote/endnote text.
Styles available for formatting tables.
Formats Table maintaining true 2-to-1 ratio. Reduces font to 11 pt to fit more on page.

Formats the Table to have the Top most and Bottom most lines Black. Opens insert table
dialog if needed.

Formats the Table to have black on All lines of table. Opens insert table dialog if needed.

Formats the Table to have Black Lines around the outside edge of table. Opens insert
table dialog if needed.

Styles available for formatting Figures.
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Ul Thesis Template Style Definitions (Continued)

UI Thesis Template
Style Name

Figure/Image Para

Insert Picture

Note/Source Line

Note/Source No Line

Lines- 1

Lines - 3

Equation Para

Reference Para

Block Quote

Extended Quote

Endnote Reference
Endnote Text

Footnote Reference
Footnote Text

Default Paragraph Font

Prelims

New Doc With UITemplate

DocABS_Separate

Style is used for...

Formats Figure/Image paragraphs by clicking to select the Figure/Image then clicking the
toolbar button. Allows you to see the complete figure or image rather than the bottom 24
pts.

Brings up the Insert Picture from file dialog box.

Formats notes for the table or figure to be single-spaced (12 pt) with double-spacing (24
pt) between each line of text. Also draws a separator line above the first note or source.

Formats notes for the table or figure to be single-spaced (12 pt) with double-spacing (24
pt) between each line of text. Use Note/Source Line for notes associated with figures.

Used for spacing. Adds one single-spaced (12 pt) line.
(i.e. around Tables and/or Figures.)

Used for spacing. Adds three single-spaced (12 pt) lines.
(i.e. around Tables and/or Figures.)

Formats equation elements, such as superscript or subscript, to allow for added character
height.

Formats References with single-spaced citations and double-spacing between each.

Formats paragraph with a first-line indentation, single-spacing and a left and right
indented margin. (See Extended Quote also.)

Formats paragraph without a first-line indentation, single-spacing and a left and right
indented margin. (See Block Quote also.)

Formats the endnote reference number.

Formats the endnote text. (12 pt)

Formats the footnote reference number.

Formats the footnote reference text. (11 pt)

Resets the font in the paragraph back to the font and size specified by the style.

This toolbar button starts an interactive macro that will create the required Preliminary
Pages. PC users: To resolve non-functioning macros or macro security warnings, please
refer to the Macro Security Settings section of this document.

Begins a new document, attached to the template, with the proper margin settings.

This toolbar button starts an interactive macro that will created PhD students Doctoral
Absract. PC users: To resolve non-functioning macros or macro security warnings, please
refer to the Macro Security Settings section of this document (PC users).
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For Assistance:

Should you find you have thesis-related concerns, we have provided you with a number of available resources. Please review the
information below and determine the appropriate contact based on your needs.

Graduate College (Academic Affairs Office)
What you should know:
As the Graduate College creates and governs the guidelines pertaining to your thesis, you will need to contact them for any
guideline or acceptability concerns you may have. Oftentimes, it is most helpful if you have an example of your concern to
present to the examiner. With that, we encourage you to stop by the Academic Affairs office and ask to speak to an examiner
with a hard copy, or fax a copy of your concern and ask that it be given to an examiner.

If you have the following (or similar) acceptability concerns, please contact the Graduate College:
e  Which fonts and font sizes are acceptable for my thesis documents?
e Is this formatting acceptable / Do | have this item formatted correctly?
e Would you be able to take a look at my documents and see if I'm on the right track?
e How can | create a PDF from multiple Word files for my electronic submission?

Contact Information: Additional Information:
Graduate College (Academic Affairs Office) In addition to obtaining assistance with specific formatting concerns, the
6 Gilmore Hall Graduate College’s “Theses & Dissertations” page
319-335-2144 (http://grad.uiowa.edu/theses-and-dissertations) also allows you to:
319-335-2806 (fax) e  Obtain a copy of the Graduate College Thesis Manual
gradcoll@uiowa.edu (email) e Learn about the ETD (Electronic Theses and Dissertations)
http://www.grad.uiowa.edu (website) submission process and policies

e Graduation/Thesis-related fees
e Upcoming Thesis Defenses

ITS Help Desk / Thesis & Dissertation Technical Support
What you should know:
If you find that any questions or concerns pertaining to the technical portion of formatting your thesis documents (e.g., you are
unable to format an item so it matches the Graduate College’s requirements, questions/concerns about a feature or function in
Microsoft Word, etc.), please contact the ITS Help Desk for assistance.

Please note: ITS will be not be able to answer questions pertaining to guidelines and acceptability — these questions or
concerns will need to be directed to the Graduate College.

Contact Information: Additional Information:

ITS Help Desk In addition to providing 1% tier support for Microsoft Office

2800 UCC (2nd floor, University Capital Centre) applications and thesis formatting concerns, the ITS Help Desk

319-384-HELP (4357) provides you with many technical resources available on their

Its-helpdesk@uiowa.edu (email) website, including (but not limited to):

http://helpdesk.its.uiowa.edu (website) e Access to several licensed software applications available

http://cs.its.uiowa.edu/sda (Thesis & Dissertation for use by U of | students, faculty and staff at no cost
Preparation Page) e Licensed software applications available at reduced cost,

including Microsoft Office, Adobe Products, reference
software and more

e Avariety of support centers to assist you with everything
from setting up your wireless connection to setting up
your email account (and nearly everything in-between)

e Assistance with purchasing a new computer

*All requests for technical assistance must begin with
the ITS Help Desk.

Ul Thesis Template for Word 2008 ver 2.1 Spring 2010


mailto:gradcoll@uiowa.edu�
http://www.grad.uiowa.edu/�
http://grad.uiowa.edu/theses-and-dissertations�
mailto:Its-helpdesk@uiowa.edu�
http://helpdesk.its.uiowa.edu/�
http://cs.its.uiowa.edu/sda�

23

Microsoft Word 2008 Resources
You can learn more about Microsoft Word 2008 and/or how to utilize various features and functions within Word 2008 in either of
the following ways:

Microsoft Word Help
Click on the Microsoft Office Word Help button in the upper right-hand corner of Word 2008 to launch Microsoft Word Help
(or press F1 on your keyboard).

Help and How-To for Microsoft Mac Office Products (Online)
Go to http://www.microsoft.com/mac/default.mspx and click Help and How-to to access training resources, demos, webcasts,
podcasts and more.
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